Using Flash

More Motion

Using Flash
More Motion
Contents
Using Flash ........................................................................................................................................................ 1
More Motion.................................................................................................................................................. 1
Exercise 1.

Motion Guides ....................................................................................................................... 2

Exercise 2.

Creating an Object From Symbols ........................................................................................ 4

Exercise 3.

Creating a Movie Clip Symbol .............................................................................................. 6

Exercise 4.

Adding Symbols to a Movie Clip .......................................................................................... 7

Exercise 5.

Checking Layers .................................................................................................................... 9

Exercise 6.

Creating the Animation ....................................................................................................... 10

Exercise 7.

Creating a Background ........................................................................................................ 12

Exercise 8.

Using a Movie Clip Symbol ................................................................................................ 13

Exercise 9.

Movie Clips that Don’t Move? ............................................................................................ 15

Animation Challenge ................................................................................................................................... 17
Policeman Body Tips .................................................................................................................................. 18

© Steve O’Neil 2009

Page 1 of 19

http://www.oneil.com.au/pc/

Using Flash

More Motion

Exercise 1. Motion Guides
When you are creating motion tweens, usually the object you are animating will move in a straight line from
one point to another. If you want to control the way your object gets from the starting point to the finishing
point, you can use a motion guide. We’ll start with a simple animation to demonstrate before using motion
guides in something more complex.

1. Create a new Flash file.
2. Create an object on the stage.

3. Select the object and convert it in to a Graphic symbol by selecting New Symbol from the Insert
menu or by pressing F8.

4. On the Layers Panel, rename by double clicking the layer name.

5. Enter Animation as the new layer name. You only have one layer at the moment but naming
layers is a good habit to get in to for when you have more than one.
6. Click on Frame 24 in the timeline. Remember that a standard animation is set to play at 12
frames per second so Frame 24 would be 2 seconds in to the animation.
7. From the Insert menu select Timeline and then Keyframe (You can also right click on the frame
and choose Insert Keyframe or you can press F6 on your keyboard).

8. Right click on the Animation layer and choose Add Motion Guide or click the icon
bottom of the Layers Panel.

at the

A new layer will be added above the animation layer. A guide layer is a special type of layer that you can use
to guide motion on a normal layer.

9. Right click on both layers and select Properties. You will see that the guide layer will have guide
selected in the properties while the Animation layer will have Guided selected in the properties.
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10. Make sure the Guide layer is selected. This is the layer we will use for drawing a motion guide.
11. Select the Pencil Tool

.

12. Draw a wavy pencil line from the object to another point on the stage.

13. Click on Frame 1 in the timeline.
14. Drag the object (remember you can hold down the Ctrl key to temporarily select the Move tool)
so that the dot in its centre is on the beginning of your guide line.

15. Click on frame 24 in the timeline.
16. Drag the object so that the dot in its centre is on the other end of the line.
17. Right click between Frame 1 and 24 on the Animation layer and select Create Motion Tween.
18. Press Ctrl Enter to test the animation. The object should travel along the guideline as it animates.
19. Close the file (you can save it for later reference if you wish)
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Exercise 2. Creating an Object From Sym bols
In an earlier exercise you created a graphic symbol, allowing you to use the same shape repeatedly in an
animation. A Movie Clip Symbol allows you to create a symbol that includes animation within the symbol.
The ability to have animation within animation adds new possibilities, allowing you to do things that
wouldn’t be possible otherwise. Movie clip symbols also allow options that aren’t available with a regular
graphic symbol.
In the following exercise we will create a movie clip that contains walking movements for a character. We
will then be able to make that figure walk around the stage.

1. Create a new blank Flash file.
2. Create the following object (or a better looking one if you’re more artistic) on your stage using
the drawing tools you have learned.
If you have trouble, see the end of this chapter for a step by step example on creating the head part (if you’re
viewing these exercises on your computer click here to go to that page now).

3. Select all parts of the object.
4. From the Modify menu select Convert to Symbol (F8).
5. Create a Graphic symbol named Policeman Body.

6. Before continuing, save your animation with Policeman as the filename.
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7. Create a new object which looks like the one shown below.

Tip:

If you want your colours for parts such as skin and shirt to match the colours in the parts

you have already drawn, you can use the eyedropper tool
already drawn when you are selecting colours.

to click on those parts you have

8. Select all parts of the new object and create a new Graphic symbol called Policeman Arm.

Note: If you wanted individual parts of the policeman to be animated, such as the eyes blinking or mouth
moving, you would need to create them as separate objects as we will be doing with the arms and legs.

We will be able to use this symbol later for both the left arm and the right arm. Before we do that though, we
will create a third symbol to use for the legs.

9. Now create a leg that looks like the following example.

10. Select all parts of the leg and make a new Graphic symbol called Policeman Leg.

You should now have the shapes you need to put together the animated Policeman.

11. Save your work before continuing.
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Exercise 3. Creating a Movie Clip Sym bol
1. Remove the arm and leg from the stage (click on each one and press Del on your keyboard).
Both will still be in the library so we can retrieve them from there later when needed.
2. Select the body segment of the policeman picture.
3. Convert the selected object to a Symbol named Policeman. This time, instead of making it a
Graphic symbol, it will need to be a Movie clip Symbol. Click on the middle registration point
(this controls which part of the symbol is used as the main reference point for things like
animation).

You will notice in the Library panel that the Movie clip symbol has an icon next to it that is different from
the Graphic symbols

4. Double click on the selected Policeman symbol on the stage, or on the symbol’s icon in the
layers panel to edit the symbol.
Below the layers panel and timeline you will now see the name of the scene (Scene 1) followed by the name
of the symbol you are editing. We will now create an animation using the symbols we have already made.
This animation will be part of the movie clip symbol.

Tip:
Remember to save often (Ctrl S). Don’t let that inevitable crash or power failure wipe out your good
work. Don’t wait to be reminded
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Exercise 4. Adding Sym bols to a Movie Clip
1. Make sure you are still editing the movie clip symbol.
2. Rename the layer in the layers panel as Body. Remember you can rename a layer by double
clicking on its name.

The policeman body symbol should still be visible on this layer.

3. Create a new layer by clicking on the Insert Layer icon

at the bottom of the layers panel.

4. Rename the new layer Left Arm.
5. From the Library panel, drag the Policeman Arm symbol on to the stage.

6. Use the Free Transform tool
example below.

to rotate, resize and position the arm so that is appears like the

7. Create a new layer by clicking on the Insert Layer icon

at the bottom of the layers panel.

8. Rename the new layer Right Arm.
9. Drag the Right Arm layer so that it is beneath the Body layer. This will make the right arm in
our animation appear behind the body.
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10. Make sure the Right Arm layer is still selected and drag another instance of the Policeman Arm
symbol form the Library panel on to the stage.
11. Use the Free Transform tool
example below.

to rotate, resize and position the arm so that is appears like the

12. Create a new layer called Left Leg.
13. Make sure the Left Leg layer is above the Body layer and below the Left Arm layer.

Tip:
When you add new layer it will appear above the layer you have selected. This means you could
select the Body layer first, to make sure the new layer appears just above it.

14. Drag an instance of the Policeman Leg symbol from the Library on to the stage.
15. Position the leg so that is looks like the example below.
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16. Create a new layer called Right Leg and place it below the Body layer and above the Left Arm
layer.
17. Add a new instance of the Policeman Leg symbol from the Library.
18. Position the right leg so that it looks like the example below.

Exercise 5. Checking La yers
One of the most common mistakes people make with animation is not putting objects on the correct layer.
When people run in to problems, it is often because they have placed more than one object on the same layer
which makes it difficult to get your animation working the way you want it to. There are a few ways of
checking that things are on the correct layer. One way is to simply click on objects.

1. Click on the right arm of your Policeman. If it has been placed on the correct layer, the name of
the layer should be highlighted in the Layers panel.
2. Check the Layers panel to make sure the Right Arm layer is highlighted.
3. Click on each part of the policeman to make sure each part is on the correct layer.
4. If there are any problems, make the necessary changes now by removing or adding symbols on
layers as needed. It’s easier to get it right before we start any animation.
Another way you can check the layers is by clicking the coloured squares next to each layer.

5. Click on the coloured square next to the Left Arm layer. Any objects on that layer will now be
shown with only an outline appearing in the same colour as the square.

6. Click the same square to show the arm normally again.
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Exercise 6. Creating the Anim ation
We will create an animation which makes it look like the arms and legs are moving in a walking motion.

1. Select the Body layer in the Layers panel. This is the only layer that won’t be moving but it will
still need to be visible for the duration of the animation.
2. Select frame 12 on the timeline (make sure it is still on the Body layer).
At 12 frames per second this frame will be 1 second in to the animation.

3. Right click on the frame and choose Insert Frame.
Since this layer won’t be animated it doesn’t need to be a Keyframe. It only needs to be visible up to frame
12. All of the frames from 1 to 12 should now be filled in. Don’t worry if your other layers appear to have
vanished. We haven’t added additional frames for the other layers yet but we are just about to.

4. Select the Left Arm layer in the Layers panel.
5. Select frame 12 in the timeline on the same layer. Since this one will be animated it will need a
Keyframe instead of a regular frame.
6. Right click on the layer and select Insert Keyframe (or press F6 on your keyboard). You will
notice that the Keyframe on this layer looks slightly different from the regular frame on the
Body layer.

Note: If you add a Keyframe and the frame has a hollow dot instead of a black dot, it is because there are
no objects on that layer.

7. With the Left Arm layer still selected add a Keyframe at frame 6 in the timeline.
8. With frame 6 still selected, change the position of the arm so that it looks like the example
below.

You might need to click on frame 1 or frame 12 to make sure that the shoulder is in the same spot at frame 6

9. Right click between frame 1 and 6 and choose Create Motion Tween.
10. Add another motion tween between Frame 6 and 12.
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11. Press Ctrl Enter to test your movie (or select Test Movie from the Control menu). Your right arm
and both legs will only be visible during the first frame, but you should see the body for the
whole animation, as well as seeing the left arm moving in a swinging motion during the
animation.
12. Close the test movie window.
13. Repeat steps 4 to 10 so that your right arm animates with a swinging motion like the left arm.
14. Select the Left Leg layer.
15. Insert a Keyframe at Frame 12 on the Left Leg timeline.
16. Insert another Keyframe at frame 6 on the Left Leg timeline.
17. With frame 6 still selected, reposition the leg so that is behind the policeman like the example
below.

18. Add motion tweens between each of the Keyframes as shown below.

19. Repeat steps 14 to 18 so that the Right leg is also animated.
Tip:
Since the policeman is on a slight angle, you can make him look a little more natural by placing the
right lag and arm slightly further to the front.

20. Press Control Enter to test the movie again. Remember that when you test a movie from a saved
flash .fla file, an up to date .swf version of the movie will also be exported to the same location
your file is saved in.
21. Save the changes to your file.
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Exercise 7. Creating a B ackg round
Now that we’ve finished animating our movie clip symbol, it’s time to make use of it in an
animation.
1. Exit symbol editing by double clicking outside the policeman, or by clicking the Scene 1 button
underneath the Layers panel.

We’re going to create a background for the scene so we’ll move him out of the way for a moment.

2. Move the policeman off to the right side of the stage (so that he is outside the white area).
Once you are back in to editing your scene you will notice that there is now only one layer and only one
frame in the timeline. All of the layers and frames that you have just been editing are all part of the
Policeman Movie Clip Symbol, not the main movie.

3. If you haven’t already renamed the layer that the policeman is on we’ll do it now. Call it (you
guessed it) Policeman.
4. Create a new layer called Background and move it below the Policeman layer.

5. Make sure the background layer is still selected. Use your shape and drawing tools to create a
background for your scene. You can use the one below as an example or create your own.

© Steve O’Neil 2009

Page 12 of 19

http://www.oneil.com.au/pc/

Using Flash

More Motion

Exercise 8. Using a Movie Clip Sym bol
Now it’s time to add our animated policeman. First we need to make sure our background is visible for the
whole duration of the animation so we will need to add frames for the background layer.

1. Our animation will last for 4 seconds (48 frames), so right click on frame 48 of the background
layer and select Insert Frame.

Our animation will involve a single motion tween with a motion guide. We want our policeman to walk
across the stage following a curved path. We will make him a different size at the end point so it looks as
though he is growing (getting closer) as he moves.

2. Select Frame 1 on the Policeman layer.
3. Resize and position the policeman so that he is positioned like the example below (still off to
the side of the stage).

Tip:
When you are resizing, use the corner and hold down shift to make sure the height and width stay in
proportion to each other.

4. Add a Keyframe at frame 48 on the Policeman layer.
5. With frame 48 still selected, move and resize the policeman so that he is slightly larger, slightly
lower and on the other side of the stage as shown.
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6. Add a motion tween between frame 1 and frame 48. Make sure the Scale option is ticked in the
tween properties below the stage.

7. Press Ctrl Enter to test your movie. The arm and leg motion that was part of the Movie Clip
Symbol will work as the symbol is used on your stage. Since it’s a symbol, you could drag more
instances from your library and have a whole group of policeman marching across your stage
with perfect precision. Try it later if you want.
At the moment, the policeman will be moving in a straight line. We’ll use a motion guide to curve his path a
little.

8. Close the movie test to return to your stage.
9. Right click on the Policeman layer and select Add Motion Guide.
10. Make sure you have the Guide layer selected (not the policeman layer).
11. Select the Pencil tool

and drag a curved line across the stage.

12. Select frame 1 and move the Policeman so that the small dot in the middle of the policeman
locks on to the right end of the guide line.

13. Select frame 48 and move the policeman so that he locks on to the left end of the guide line.
14. Test the animation. The policeman should now follow the curved line as he moves.
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Exercise 9. Movie Clips that Don’t Move?
You can use movie clips for symbols that won’t include any animation but why would you want to? Well for
one thing, a movie clip symbol can do things a Graphic symbol can’t, like use some of the build in effects.
We’ll use one such effect in the following steps to add some 3d clouds to our animation.

1. Add a new layer called Clouds to your animation. Make sure the new layer is on top of all the
other layers.

2. Using the tools available, draw a cloud on the new layer.
3. Draw a second cloud near the first one.
4. Select both clouds. We will make both clouds in to a single object so that they can move
together.

5. Create a new Movie Clip Symbol called clouds

6. We will animate the clouds so that they move across the sky in the top of the movie. Position
the clouds off the left side of the stage.

7. Create a Keyframe at Frame 48 and position the clouds on the other side of the stage.
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8. Add a Motion Tween to the Clouds layer so that the clouds move from one side of the stage to
the other.
The last thing we’ll do is use a filter to change the look of the Clouds symbol. This wouldn’t be possible if
we had made the clouds in to a regular Graphic symbol.

9. Make sure the Clouds symbol is selected at frame 1 on the timeline.
10. Click the Filters tab in the Properties Panel below the stage.

11. Click the Add Filter button.

12. Select Bevel from the menu that appears.
13. From the options to the side, set the quality to High.
14. Try some of the other options until you like the look of your clouds.
15. You might need to go to frame 48 and check that the options for the Bevel are the same as they
are on frame 1 (including the Strength and Distance options).
16. Test your animation to see how the clouds look.
17. Save the animation when you’re satisfied with the changes.
Tip:
You could also make the clouds semi transparent by changing the Colour option of the symbol (in
the Properties Panel) to Alpha and adjusting the transparent amount.
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Anim ation C hallenge
Use what you have learned to create an animation like the one below. The car should be travelling along the
road (using a motion guide) and the wheels should be rotating (so the car will need to be a Movie Clip
Symbol with rotating wheels inside that symbol).

Refer to http://oneil.com.au/pc/flash.html for a completed example that you can refer to if you get stuck.
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Policem an B ody Tips
Note: When you follow these instructions, your policeman might not look identical to the one in the
exercises since we’re not following any exact measurements. Even the one in these steps below will differ
slightly from the one shown in the main exercises. You will probably find most of these steps a lot easier if
you zoom in since some parts of the face (such as they eye) will be quite small.

We’ll start with the head.

1. Select the Oval tool

(remember it is grouped with the Rectangle tool)

2. Select a thin black line style for the stroke (outline) with a skin colour for the fill. The colour
options in the Properties panel below your stage should look similar to the ones below.

3. Draw an oval shape for the head and another smaller oval for the nose as shown below.

We’re going to use the eraser tool to remove the right side of the nose before attaching it to the face.

4. Select the Eraser tool.
5. Use the eraser to remove the end part of the nose.
6. Use the Select tool
to move the nose on to the face (you hold down Ctrl to temporarily
activate the move tool so you don’t have to click the icon). Remember to make sure you double
click to select the stroke as well as the fill.

7. Select the Oval tool again. Keep the thin black outline but this time select a solid white fill
colour.
8. Draw a small oval for the eye (If you’re worried you might not get it the right shape or size the
first time, draw it off to the side. Then if you’re not happy with it, you can simply delete it and
try again).
9. Select the Brush tool.
10. Select a suitable brush size and set the fill colour to the colour you want the middle of the eye to
be.
11. Use the brush to paint a small dot inside the eye.
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. You should still have a thin black line in the stroke settings.

13. For drawing the mouth, make sure the pencil mode at the bottom of the toolbar is set to Smooth.
14. Draw a small line for the mouth.
15. With the pencil tool still selected, change the stroke colour to the colour you want
the hair to be.
16. Draw a hairline on the head.
17. Select the Fill tool.
18. Set the fill colour to the same colour as the hairline and click inside the hairline area to fill with
the hair colour.

19. Select the Rectangle tool.
20. Set both the Stroke and Fill colours to black.
21. Draw one rectangle for the hat, with another thinner rectangle making up the front of the hat.
You might want to draw it above the head first and then move it in to pace afterward.
22. Add the badge on the hat (in this example it’s been done with the rectangle tools, though it
could be done with other tools).

23. Move the hat in to place.
Head and hat complete! Now you should be able to use the same techniques to create the body and
the other parts of the animation.
If you are reading these tutorials on your computer click here to return to the exercise where you were
creating the policeman.
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